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1. WPROWADZENIE 
W ćwiczeniu zostanie zaprezentowany sposób modelowania skraplania się pary na 

płaskiej poziomej płycie. Modelowanie zjawisk zmiany fazy (skraplanie, parowanie) jest 

bardzo trudne. W tym ćwiczeniu zostanie zaprezentowany jeden z modeli skraplania 

o nazwie Wall Condensation Model [1]. Płyta o temperaturze 90°C omywana jest 

mieszaniną pary nasyconej i powietrza (gazu niekondensującego) z prędkością 0,1 m/s. 

Temperatura mieszaniny wynosi 100°C, a udział masowy pary wynosi 95%. W celu 

skrócenia czasu obliczeń przypadek zostanie zamodelowany jako dwuwymiarowy. 

Schemat analizowanego przypadku przedstawiony jest na rys. 1.  

 

Rys. 1. Schemat zagadnienia skraplania się pary na płaskiej płycie  
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2. DWUWYMIAROWE SKRAPLANIE NA PŁASKIEJ PŁYCIE 
2.1. PRZYGOTOWANIE GEOMETRII 

Wykonaj następujące zadania: 

1) Otwórz program Ansys Workbench i zapisz projekt o nazwie Cw4 w katalogu 

o nazwie Cw4 (File->Save As).  

ZASADA PRAKTYCZNA NR 1: Dla każdego projektu tworzymy osobny 

katalog 

ZASADA PRAKTYCZNA NR 2: W nazwach katalogów nie stosujemy: spacji, 

znaków specjalnych (np. @#$%^&* itp.) oraz polskich znaków 

 
 

2) Wybierz moduł Mesh i otwórz program Spaceclaim. W tym celu chwyć lewym 

przyciskiem myszy (LPM) moduł Mesh i przeciągnij go do pola Project 

Schematic. Następnie kliknij dwukrotnie LPM na Geometry w celu 

uruchomienia programu Spaceclaim, w którym zostanie utworzona geometria. 

Zwróć uwagę, że w lewym dolnym rogu ekranu pojawia się napis informujący 

jaki program jest uruchamiany. 



 



 



3) Kliknij LPM ikonę Select New Sketch w celu wybrania płaszczyzny 

rysowania. 

 
Wybierz płaszczyznę X-Y jak na rysunku poniżej. 

 
 

4) Kliknij ikonę Plan View w celu obrócenia płaszczyzny rysowania 

równolegle do ekranu (możesz też to zrobić wciskając Shift + v). 

 
 

5) W panelu u góry ekranu wybierz ikonę rysowania prostokąta  i zbliż kursor 

do środka ukłdu współrzędnych po czym naciśnij klawisz LPM. 



 
Pomiędzy polami edycji wymiaru można się przełączać klawiszem Tab. Ustaw 

wymiar poziomy na 100 natomiast pionowy na 30 mm i naciśnij klawisz Enter. 

 
Pamiętaj, że w razie niepowodzenia w każdym momencie możesz kliknąć ikonę 

cofnięcia  (znajduje się w lewym górnym rogu ekranu) lub Ctrl + z.  

 



6) W celu wyjścia z polecenia rysowania prostokąta naciśnij klawisz Esc i LPM 

kliknij ikonę przejścia do rysowania 3D widoczną u dołu ekranu. 

 
7) Obróć widok za pomocą przytrzymania przycisku myszy Scroll i jego 

przesunięcia tak, aby uzyskać widok izometryczny podobny do tego poniżej. 

 
8) Wybierz polecenia Pull 

 
Następnie ustaw kursor tak jak pokazano na rysunku poniżej 

 

Przesuwając kursor przy wciśniętym LPM zauważysz zmieniający się wymiar 

długości rury. Wpisz 5 mm i zatwierdź Enter (możliwe, że będziesz musiał to 

zrobić przy wciśniętym LPM). 



 
 

9) Zamknij program Spaceclaim i zapisz projekt w Workbench za pomocą Ctrl + s 

 

2.2. PRZYGOTOWANIA SIATKI NUMERYCZNEJ 

1) W tym celu otwórz program Ansys Meshing przez dwukrotne kliknięcie LPM 

Mesh 

 



 
2) W programie Ansys Meshing: 1) kliknij Mesh, 2) Zmień pole Physisc 

Preference na CFD, 3) Zmień pole Solver Preference na CFX, 4) Kliknij LPM 

Generate Mesh 



 
Domyślna siatka nie  jest poprawna. Siatkę należy edytować. 

1 

2 

3 

4 



 
3) W Ansys Meshing naciśnij prawy przycisk myszy (PPM) na Mesh i wybierz 

Insert->Sizing 

 
U góry ekranu wybierz filtr wybierania krawędzi Edge 

 



Przy wciśniętym klawiszu Ctrl wybierz 4 krawędzie jak na rysunku poniżej 

i zatwierdź Geometry->Apply (jeśli nie widać Apply kliknij LPM w żółte pole). 

 

 
Zmień pole Definition jak na rysunku poniżej 



 
Kliknij Generate Mesh i sprawdź wygenerowaną siatkę (jeśli nie widać siatki 

kliknij LPM na Mesh w drzewku po lewej stronie). 

4) W Ansys Meshing naciśnij prawy przycisk myszy (PPM) na Mesh i wybierz 

Insert->Sizing. Przy wciśniętym klawiszu Ctrl wybierz 4 krawędzie jak na 

rysunku poniżej i zatwierdź Geometry->Apply (jeśli nie widać Apply kliknij 

LPM w żółte pole). 

 
Zastosuj poniższe ustawienia 



 
Kliknij Generate Mesh i sprawdź wygenerowaną siatkę (jeśli nie widać siatki 

kliknij LPM na Mesh w drzewku po lewej stronie). Siatka nie jest symetryczna. 

Aby to zmienić wybierz LPM opcję Reverse Bias 

 
Następnie wskaż 2 krawędzie jak na rysunku poniżej i zatwierdź Apply. 



 
Kliknij Generate Mesh i sprawdź wygenerowaną siatkę (jeśli nie widać siatki 

kliknij LPM na Mesh w drzewku po lewej stronie). 

 

 
5) W Ansys Meshing naciśnij prawy przycisk myszy (PPM) na Mesh i wybierz 

Insert->Sizing. Przy wciśniętym klawiszu Ctrl wybierz 4 krawędzie jak na 

rysunku poniżej i zatwierdź Geometry->Apply (jeśli nie widać Apply kliknij 

LPM w żółte pole). 



 
Zastosuj poniższe ustawienia 

  
Kliknij Generate Mesh i sprawdź wygenerowaną siatkę (jeśli nie widać siatki 

kliknij LPM na Mesh w drzewku po lewej stronie). 

 
 

6) Ostatni krok to nadanie nazw objętościom i powierzchniom. 

Wybierz LPM filtr wyboru brył 

 
Wybierz prostopadłościan LPM, a następnie kliknij PPM i wybierz Create 

Named Selection 



 

 
Jako nazwę proszę wybrać Fluid_domain 

 
7) Następnie zmień filtr na wybór powierzchni 

 



LPM wskaż zewnętrzną powierzchnię, przy której siatka się zagęszcza i kliknij 

PPM, a następnie wybierz Create Named Selection  

 

 
Nadaj nazwę cold_wall 



 
8) Utwórz nazwę inlet dla powierzchni jak na rysunku poniżej 

 



 
9) Utwórz nazwę outlet na przeciwległej powierzchni do inlet 

 



 
10) Podobnie utwórz nazwę sym dla dwóch dużych powierzchni płaskich  



 



 
11) Na ostatniej nie nazwanej powierzchni nadaj nazwę slip_wall 



 



 
12) Zamknij moduł Ansys Meshing i zapisz projekt w Workbench. 

 

 

 

 

2.3. PRZYGOTOWANIE MODELU NUMERYCZNEGO 

1) Wstaw moduł CFX 



 
W celu połączenia modułu Mesh z CFX chwyć LPM Mesh (to niżej) i 

przeciągnij na Setup aż do pojawienia się pola Transfer A3, a następnie puść 

LPM – połączenie zostało utworzone 

 
Kliknij PPM na Mesh i wybierz Update 



 
 

Kliknij dwukrotnie Setup w celu uruchomienia programu Ansys CFX 



 
2) Otwórz Analysis Type przez dwukrotne kliknięcie LPM 



 
Zastosuj następujące ustawienia i zatwierdź OK. 

 

 
3) Kliknij dwukrotnie LPM Default Domain 

 
Zastosuj następujące ustawienia wybierz przycisk importowania materiałów 

 z bibliotek CFX . 



 
4) Wybierz ikonę Import library data 

 
 

5) Przy wciśniętym klawiszu Ctrl wybierz materiały H2O i H2Ol i zatwierdź OK. 



 
I ponownie zatwierdź OK. 

 
6) Zamknij na razie Default Domain 



 

7) Utwórz nowy materiał o nazwie H2Olv klikając ikonę  



 
8) Zastosuj poniższe ustawienia 

 
 

Przejdź do zakładki Saturation Properties i zastosuj jak poniżej 

 

 
Zatwierdź OK. 

9) Wybierz ikonę tworzenia nowego materiału i nazwij go Steam 

 
10) Zmień Option na Variable Composition Mixture i w pole Material List wybierz 

Air Ideal Gas oraz materiał H2O. W celu wyboru dwóch materiałów 

Pamiętaj, aby przed 

wpisaniem formuł 

nacisnąć LPM ikonę 

expression 



wykorzystaj ikonę  oraz przytrzymaj klawisz Ctrl przy wyborze. Zatwierdź 

OK. 

 
 

Następnie ponownie zatwierdź OK. 



 
 

11) Kliknij dwukrotnie LPM Default Domain 



 
12) Zastosuj następujące ustawienia 

 
 



 
 



 
Zatwierdź OK. 

13) Utwórz warunek brzegowy o nazwie inlet 

 
Zastosuj ustawienia jak poniżej i zatwierdź OK. 



 
 

 
 

 

 

14) Utwórz warunek brzegowy outlet 

 



 
 

 
15) Utwórz warunek brzegowy slipWall 

 

 
 

 
16) Utwórz warunek brzegowy condensingWall 



 
 

 
 

 
17) Utwórz warunek brzegowy sym 

 
Zastosuj ustawienia jak poniżej i zatwierdź OK. 



 
18) Utwórz expression o nazwie Cond Mass Flux 

 
 

 

19) Zastosuj następującą definicję: areaAve(H2O.Condensation Mass 

Flux)@condensingWall  

Zatwiedź Apply. 

 
 

20) Otwórz Output Control 



 
Zastosuj poniższe ustawieania i zatwierdź OK. 



 
 

 
21) Utwórz warunki początkowe przez kliknięcie LPM ikony Global Initialization 

(u góry ekranu, prawie na środku) 

 
Zastosuj ustawienia jak poniżej i  zatwierdź OK. 

 

Pamiętaj, aby przed 

wpisaniem formuł y 

nacisnąć LPM ikonę 

expression 



 
 

22) Otwórz Solver Control i zastosuj poniższe ustawienia 



 



 
Zatwierdź OK. 

23) Zamknij program Ansys CFX. 

 

2.4. OBLICZENIA 

1) Kliknij dwukrotnie pole Solution w celu uruchomienia programu Ansys CFX 

Solver Manager 



 
2) Zastosuj poniższe ustawienia i naciśnij Start Run. Program wykona obliczenia. 

Zaczekaj kilka chwil na komunikat o zakończeniu obliczeń. 



 
3) Obliczenia trwają około 10 minut. Obserwuj poszczególne zakładki reziduł jak 

się zmieniają. Szczególnie zwróć uwagę na zakładkę User Point, gdzie 

pokazany jest strumień skondensowanej pary w każdej iteracji. Stan ustalony 

będzie osiągnięty, gdy krzywa ustabilizuje się, co nastąpi po około 350 

iteracjach. Dodatkowe 250 iteracji (ustawione zostały 600 iteracji w punkcie 

2.3.22) zostają przeprowadzone, aby wszystkie reziduły też się ustabilizowały. 



 
4) Po skończeniu obliczeń program  wyświetli komunikat: 

 
5) Zatwierdź OK i zamknij Ansys CFX Solver Manager. Zapisz projekt 

w Workbench. 

 



2.5. OPRACOWANIE WYNIKÓW 

 

1) Kliknij dwukrotnie LPM Results w celu uruchomienia programu Ansys CFD 

Post i obejrzenia wyników 

 
2) Z menu Location wybierz Plane 



 
Zastosuj poniższe ustawienia i zatwierdź Apply. 

 
3) LPM naciśnij oś X 



 
4) Odznacz widoczność utworzonej wcześniej płaszczyzny. 

 
5) Wybierz tworzenie konturów i zatwierdź OK. 

 
Zastosuj poniższe ustawienia i zatwierdź Apply. 



 
 

6) Zapisz zdjęcie konturów frakcji wody. Do tego celu możesz też użyć ikony 

. 

 
 

 
 

7) Zapisz zdjęcie konturów temperatury. Aby to zrobić kliknij dwukrotnie LPM na 

utworzone w drzewie kontury i zmień zmienną na Temperature.  

Tu można zobaczyć 

gdzie jest 

zapisywane zdjęcie 



 
 

 
8) Zapisz zdjęcie konturów prędkości. Aby to zrobić kliknij dwukrotnie LPM na 

utworzone w drzewie kontury i zmień zmienną na Velocity. 

9) Następnie wyłącz widoczność konturów. 

 

 



 

10) Kliknij LPM na oś Y 

 
11) W drzewku systemowym włącz widoczność powierzchni condensingWall 

i następnie dwukrotnie kliknij LPM w nazwę condensingWall. Zastosuj 

poniższe ustawienia i kliknij ikonę  

 



 
 

Wybierz zmienną H2O.Condensation Mass Flux i zatwierdź OK. 

 

 



 
 

Zatwierdź Apply. 



 
Zapisz zdjęcie. 

 

12) Wyłącz widoczność powierzchni condensingWall w drzewie systemowym. 

13) Utwórz linię i zastosuj następujące ustawienia: 



 
 

 
 



 
14) Utwórz wykres 

 
15) Zastosuj ustawienia i zatwierdź Apply. 

 
 



 
 

 
16) Wyeksportuj wyniki wykresu do pliku csv 



 
 

 
 

 



Wyniki jakie należy umieścić w raporcie: 

I. Kontury rozkładów udziału masowego wody w domenie obliczeniowej. 

II. Kontury rozkładów temperatury w domenie obliczeniowej. 

III. Kontury rozkładów prędkości w domenie obliczeniowej. 

IV. Zdjęcie zmiennej H2O.Condensation Mass Flux na powierzchni zimnej ściany. 

V. Porównaj na jednym wykresie wyniki analityczne (1) i numeryczne (wyniki 

z wyeksportowanego pliku csv). 

 

Dla rozważanego przypadku istnieje rozwiązanie analityczne przedstawione 

przez Sparrowa i in. [1]. Strumień masy kondensującej pary mcond zmienia się 

wzdłuż płyty następująco 

 1
(0)

2
cond

U
m F

x

 =   (1) 

 

gdzie 

  gęstość mieszaniny, kg/m3 

  lepkość dynamiczna mieszaniny, P s 

U
 prędkość przepływu niezaburzonego (wlotowa), m/s 

x  współrzędna wzdłuż długości płyty, m 

(0)F  funkcja zależna min. od udziału masowego gazu niekondensującego 

 

Do obliczeń analitycznych proszę dla uproszczenia przyjąć właściwości 

kondensatu w temperaturze nasycenia 100°C. Potrzebne wartości zmiennych 

przedstawiono w tab. 1. 

Tab. 1. Wartości zmiennych, które należy podstawić do równania (1) 

ρ 

kg/m3 

µ 

Pa s 

U∞ 

m/s 

F(0) 

 

958,35 0,000281745 0,1 0,05 

 

Na wykresie nie przedstawiać wyników dla x = 0. 

 

 

Zadania nieobowiązkowe: 

1) Wykonaj obliczenia dla frakcji masy pary wodnej 50% i porównaj 

z przypadkiem podstawowym zestawiając odpowiednio ze sobą wyniki I)-V). 

2) Oblicz współczynnik wnikania na powierzchni płyty dla obu przypadków. 
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